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1. Overview 

Simulations become a necessary tool in the hands of researchers. Although most of scientific 

computing is based on numerical solutions to partial differential equations, the discrete event 

simulation and hybrid system [5,13] found wide applications in science and engineering. Even 

within the research group at RPI within which this project has been done, the applications 

encompassed spatially explicit simulations [16] including epidemic simulation [3,22], vector born 

disease modeling [2], Lyme disease simulation [17,18], evolution of virulence [24] and epidemics 

[23] as well as more general ecological models [21]. Other scientific applications of discrete event 

simulations include speculative execution of scientific codes [4] and plasma simulation [25]. In 

computer science, these methods are used to simulate embedded computer systems [1], distributed 

and grid computing [19,20] and networking [26,30], including on-line network simulations [27], 

network management applications [29] and large scale network dynamics studies [28].  

Based on this broad experience in applications, the RPI group developed new rollback 

procedure [15] and new synchronization protocol based on lookback [9.10], as well as new 

approach to developing discrete event simulation based on components [6,7,8]. The new system, 

called COST [11] includes a tool for configuring a simulation from its components [12] and found 

its first application in emergency management [14]. It is difficult to configure simulations using 

linear language and this observation was the motivation for this project: development of a 

graphically oriented configuration tool. 

 The Component-based Simulation Visualization Toolkit (CSVT) is to provide a visualization 

interface for simulation programs (called simulation clients) to help simulation developers verify 

and debug the simulation more easily and more comfortably. It is developed in Java, so users can 

use it on any platform. The topology of the network simulation is provided in a text file, CSVT can 

read in the topology file, and give an automatic layout solution. Then the user can adjust the graph 

to meet his needs, and save the view into a serialized view file or a JPEG file.   

2. User Manual 

You can either create a text file describing the topology of the network, and use CSVT to read 

in the text file, the topology will then be displayed in a graphic manner; or, customize the source 

code of CSVT to meet your specific needs. For customizing CSVT, please refer to the third part of 

this report, the implementation manual. 

2.1  Function sets 

A simulation is composed of a number of components. A component contains one or more 

ports which are connected to corresponding ports of other components. Each simulation, 

component, or port has a unique name. 

The CSVT visualizes the topology of the simulation. In the simplest form, each component is 

symbolized as a rectangle. However, the visualization of components should be extendable. New 

symbols can be easily added by implementing customized JAVA drawing classes. The simulation 

developer can then select a symbol for a component by specifying the desired drawing class. On the 

contrary, a port is invariably represented by a triangle. 

The CSVT allows the user to adjust the graphical structure of topology, such as moving and 



changing the path of the link between ports. The topology itself, which is determined by the 

simulation client, is not modifiable. Therefore, functionalities such as disconnecting a port, creating 

a new component or a port, are not necessary. 

After the user adjust the positions of components, ports, and links, the CSVT can save the 

geographical information along with their names to a view file which is identified by the name of 

the simulation. When the same simulation is restarted, the CSVT is able to retrieve such 

information from the view file so that the user doesn’t need to fix the positions again. 

2.2  Launching CSVT 

CSVT can be started by “ java -classpath edu.rpi.cs.CSVT.CSVT”, under the CSVT directory. 

The interface will be as the following: 

 

2.3  How to use CSVT 

2.3.1 Create a graph 

 

 

There are three ways to create a CSVT graph. 



1) File -> New Graph 

In this way, you create a blank graph, and can use the tool box provided to add in 

components from the component library. The component library can be customized to 

meet your needs, that is, you can change the CSVT code to provide your own components. 

CSVT supports Drag and Drop function, so creating a new graph is easy. 

 

 

 

2) File -> Load Topology 

 

You can also put the graph topology into a text file like this: 

“  component source  

component fifo 

component server 

component sink 

outport source.out 

inport fifo.in 

outport fifo.out 

inport fifo.next 

inport server.in 

outport server.out 

outport server.next 

inport sink.in 

outport sink.out 

connect source.out fifo.in 

connect fifo.out server.in 

connect server.next fifo.next 



connect server.out sink.in”  

 

 and the loaded CSVT graph will be as the following: 

 

 
  

 then you can adjust the attributes of the components, and finally you can get the following: 

 

  

 

3) File -> Open 

 

This is just to open an existed CSVT graph file. 



2.3.2 Output a graph 

The adjusted view file can be saved into a serialized file by File -> Save As, or to a JPEG file 

by File-> Save as JPEG. 

2.3.3 Standard editing functions 

CSVT supports copy, paste, cut and delete, and Undo/Redo functions for editing a graph. 

 

2.3.4 Zoom in and out 

You can zoom in to see in more detail, and zoom out to see the global scope. 

 

 

2.3.5 View choices 

You can customize the look and feel style by View->Look and Feel : 



 
 

and some other view choices like Grid -> Visible:  

 

 

2.3.6 Graph layout 

  CSVT supports several automatic layout methods: 



 

 

2.4  System requirements 

CSVT has been developed under windows 2000, J2SE v1.4. It runs properly on Solaris 

and Linux platform, but on Solaris, mouse right button doesn’t work, so to fully support 

mouse function, currently better use under windows or Linux. 

3. Implementation Manual 

3.1 How to manage graphs 

With CSVT’s JGraph class, you can display objects and their relations. A JGraph object 

doesn't actually contain your data; it simply provides a view of the data. Like any non-trivial Swing 

component, the graph gets data by querying its data model. Here's a picture of a graph: 

 

 
Fig. 1: A directed graph 

 

As the preceding figure shows, JGraph displays its data by drawing individual elements. Each 



element displayed by the graph contains exactly one item of data, which is called a cell. A cell may 

either be a vertex, an edge or a port. Vertices have zero or more neighbours, and edges have one or 

no source and target vertex. Each cell has zero or more children, and one or no parent. (Instances of 

ports are always children of vertices.) 

3.1.1 Creating a Graph 

 The following code creates a JGraph object: 

JGr aph gr aph = new JGr aph( ) ;  

. . .  

JScr ol l Pane scr ol l Pane = new JScr ol l Pane( gr aph)  

The code creates an instance of JGraph and puts it in a scroll pane. Jgraph’s constructor is 

called with no arguments in this example. Therefore, JGraph will use an instance of 

Def aul t Gr aphModel , create an instance of Gr aphVi ew for it, and add a sample graph to the 

model. 

Graph can be created by invoking the JGraph constructor. You should probably put the graph 

inside a scroll pane, so that the graph won't take up too much space. You don't have to do anything 

to support cell editing, selection, marquee selection, vertex and edge resizing and moving. 

3.1.2 Customizing a Graph 

After the network topology is loaded into the CSVT environment, you can customize the 

attributes of the graph. CSVT offers the following forms of interactions: 

• In-place editing 

• Moving 

• Cloning 

• Sizing 

• Bending (Adding/Removing/Moving edge points) 

• Establishing Connections 

• Removing Connections 

All interactions can be disabled using set Enabl ed( f al se) . In-place editing is available 

for both, vertices and edges, and may be disabled using set Edi t abl e( f al se) . The number of 

clicks that triggers editing may be changed using set Edi t Cl i ckCount . 

Moving, cloning, sizing, and bending, establishing connections and disconnecting edges may 

be disabled using the respective methods, namely set Moveabl e, set Cl oneabl e, 

set Si zeabl e, set Bendabl e, set Connect abl e and set Di sconnect abl e on the 

graph instance. 

The model offers finer control of connection establishment and disconnection based on the 

accept sSour ce and accept sTar get  methods. By overriding these methods, you can decide 

for each (edge, port) pair if it is valid with respect to the edge’s source or target. (Before an edge is 

disconnected from a port, the respective method is called with the port set to nul l  to check if 

disconnection is allowed.) 



Cel l Vi ews  offer yet another level of control in that they allow/disallow being edited, moved, 

cloned, resized, and shaped, or connected/disconnected to or from other cells. (Note: In the context 

of multiple views, a cell may be connectable in one view, and not connectable in another.) 

There are a number of additional methods to customize CSVT, for example, 

set Mi ni mumMove to set the minimum amount of pixels before a move operation is initiated, and 

set SnapSi ze to define the maximum distance from a cell to be selected. 

With set Di sconnect OnMove you can indicate if the selection should be disconnected 

from the unselected graph when a move operation is initiated, set Dr agEnabl ed 

enables/disables the use of Drag-and-Drop, and set Dr opEnabl ed sets if the graph accepts 

Drops from external sources. (The latter also affects the clipboard, in that it allows/disallows paste 

data from external sources.) 

3.1.3 Responding to Interaction 

You can either respond to mouse events, or to events generated by CSVT. CSVT offers the 

following notifications: 

• Changes to the model 

• Changes to the view 

• Changes to the selection 

• Undoable edit happened 

3.1.3.1. Undoable edit 

CSVT is compatible to Swing’s Undo-Support. Each time the user performs an action, the 

model dispatches an edit that describes the change. The edit provides an undo method to undo the 

change. 

If undo is called on an edit, the model fires a Gr aphModel Event , but it does not fire an 

Undoabl eEdi t Event . The latter only fires if CSVT wants to indicate that an edit was added to 

the command history, which is not the case for an undo. (In the context of multiple views, you 

must use an instance of Gr aphUndoManager  to ensure correctness.) 

3.1.3.2. Responding to Mouse Events 

For detection of double-clicks or when a user clicks on a cell, regardless of whether or not it 

was selected, a MouseLi st ener  should be used in conjunction with 

get Fi r st Cel l For Locat i on. The following code prints the label of the topmost cell under 

the mouse pointer on a doubleclick. (The get Fi r st Cel l For Locat i on method scales its 

arguments.) 

/ /  MouseLi st ener  t hat  Pr i nt s t he Cel l  on Doubl ecl i ck 

gr aph. addMouseLi st ener ( new MouseAdapt er ( )  {  

  publ i c  voi d mousePr essed( MouseEvent  e)  {  

    i f  ( e. get Cl i ckCount ( )  == 2)  {  

      / /  Get  Cel l  under  Mousepoi nt er  

      i nt  x  = e. get X( ) ,  y  = e. get Y( ) ;  



      Obj ect  cel l  = gr aph. get Fi r st Cel l For Locat i on( x,  y) ;  

      / /  Pr i nt  Cel l  Label  

      i f  ( cel l  ! = nul l )  {  

        St r i ng l ab = gr aph. conver t Val ueToSt r i ng( cel l ) ;  

        Syst em. out . pr i nt l n( l ab) ;  

      }  

    }  

  }  

} ) ;  

3.1.3.3. Responding to Model Events 

If you want to handle model notifications, implement the Gr aphModel Li st ener  interface 

and add the instance using the method addGr aphModel Li st ener . The listeners are notified 

when cells are inserted, removed, or when the label, source, target, parent or children of an object 

have changed. (Make sure to also add an Obser ver  to Gr aphVi ew in order to be notified of all 

possible changes to a graph.) 

The following code defines a listener that prints out information about the changes to the 

model, and adds the listener to the graph’s model: 

/ /  Def i ne a Model  Li st ener  

publ i c  c l ass Model Li st ener  i mpl ement s Gr aphModel Li st ener  {   

  publ i c  voi d gr aphCel l sChanged( Gr aphModel Event  e)  {  

    Syst em. out . pr i nt l n( " Change:  " +e. get Change( ) )  

  }  

}  

/ /  Add an I nst ance t o t he Model  

gr aph. get Model ( ) . addGr aphModel Li st ener ( new Model Li st ener ( ) ) ;  

3.1.3.4. Responding to View Events 

Visual modifications are typically handled by the Gr aphVi ew, which extends the 

Obser vabl e class. To respond to view-changes, implement the Obser ver  interface and add it 

to the view using the method addObser ver . Observers are notified when the size, position, color 

etc. of a cell view has changed. (Note: If the model’s i sAt t r i but eSt or e returns t r ue, then 

the view is bypassed, and all attributes are stored in the model.) 

/ /  Def i ne an Obser ver  

publ i c  c l ass Vi ewObser ver  i mpl ement s Obser ver  {   

  publ i c  voi d updat e( Obser vabl e o,  Obj ect  ar g)  {  

    Syst em. out . pr i nt l n( " Vi ew changed:  " +o) ;  

  }  

}  

/ /  Add an I nst ance t o t he Vi ew 

gr aph. get Vi ew( ) . addObser ver ( new Vi ewObser ver ( ) ) ;  



3.1.3.5. Responding to Selection Changes 

The following code prints out selection events: 

/ /  Def i ne a Sel ect i on Li st ener  

publ i c  c l ass MyLi st ener  i mpl ement s Gr aphSel ect i onLi st ener  {   

  publ i c  voi d val ueChanged( Gr aphSel ect i onEvent  e)  {  

    Syst em. out . pr i nt l n( " Sel ect i on changed:  " +e) ;  

  }  

}  

/ /  Add an I nst ance t o t he Gr aph 

gr aph. addGr aphSel ect i onLi st ener ( new MyLi st ener ( ) ) ;  

The preceding code creates an instance of MyLi st ener , which implements the 

Gr aphSel ect i onLi st ener  interface, and registers it on the graph. 

3.1.3.6. Responding to Undoable Edits 

To enable Undo-Support, a Gr aphUndoManager  must be added using 

addUndoabl eEdi t Li s t ener . The Gr aphUndoManager  is an extension of Swing's 

UndoManager  that maintains a command history in the context of multiple views. You can safely 

use an instance of UndoManager  if your graph has only one view. Otherwise, a 

Gr aphUndoManager  must be used for correct behaviour. 

3.1.4 Customizing a Graph’s Display 

CSVT performs some look-and-feel specific painting. You can customize this painting in a 

limited way. For example, you can modify the grid using set Gr i dCol or  and set Gr i dSi ze, 

and you can change the handle colors using set Handl eCol or  and set LockedHandl e-  

Col or . The background color may be changed using set Backgr ound. 

3.1.4.1. Subclassing Renderers 

If you want finer control over the rendering, you can subclass one of the default renderers, and 

override its pai nt -method. A renderer is a Component -extension that paints a cell based on its 

attributes. Thus, neither JGraph nor its look-and-feel-specific implementation actually contain the 

code that paints a cell. Instead, CSVT uses the cell renderer’s painting code. A new renderer may be 

associated with a cell by overriding the get Render er Component  method of the corresponding 

Cel l Vi ew, or the get Render er  method for extensions of the Abst r act Cel l Vi ew class. 

3.1.4.2. Adding new Cell Types to a Graph 

The following code is to illustrate how to add new cell types and renderers. The code adds an 

oval vertex to the graph. The easiest way to do this is by extending JGraph. Since JGraph 

implements the Cel l Vi ewFact or y  interface, it is in charge of creating views. 

When creating a view, JGraph assumes a cell is a vertex if it is not an instance of Edge or 

Por t , and calls the cr eat eVer t exVi ew method. Thus, we only need to override this method to 

identify an oval vertex (based on a type test) and return the corresponding view. 



/ /  Over r i des JGr aph. cr eat eVer t exVi ew 

pr ot ect ed Ver t exVi ew cr eat eVer t exVi ew( Obj ect  v,  

                                      Gr aphModel  model ,  

                                      Cel l Mapper  cm)  {  

  / /  Ret ur n an El l i pseVi ew f or  El l i pseCel l s 

  i f  ( v  i nst anceof  El l i pseCel l )  

    r et ur n new El l i pseVi ew( v,  model ,  cm) ;  

  / /  El se Cal l  Super c l ass 

  r et ur n super . cr eat eVer t exVi ew( v,  model ,  cm) ;  

}  

The oval vertex is represented by the El l i pseCel l  class, which is an extension of the 

Def aul t Gr aphCel l  class, and offers no additional methods. It is only used to distinguish oval 

vertices from normal vertices. 

/ /  Def i ne El l i pseCel l  

publ i c  c l ass El l i pseCel l  ext ends Def aul t Gr aphCel l  {  

  / /  Empt y Const r uct or  

  publ i c  El l i pseCel l ( )  {  

    t hi s( nul l ) ;  

  }  

  / /  Const r uct  Cel l  f or  User obj ect  

  publ i c  El l i pseCel l ( Obj ect  user Obj ect )  {  

    super ( user Obj ect ) ;  

  }  

}  

The El l i pseVi ew is needed to define the special visual aspects of an ellipse. It contains an 

inner class which serves as a renderer that provides the painting code. The view and renderer are 

extensions of the Ver t exVi ew and Ver t exRender er  classes, respectively. The methods that 

need to be overridden are get Per i met er Poi nt  to return the perimeter point for ellipses, 

get Render er  to return the correct renderer, and the renderer’s pai nt  method. 

/ /  Def i ne t he Vi ew f or  an El l i pseCel l  

publ i c  c l ass El l i pseVi ew ext ends Ver t exVi ew {  

  s t at i c  El l i pseRender er  r ender er  = new El l i pseRender er ( ) ;  

  / /  Const r uct or  f or  Super cl ass 

  publ i c  El l i pseVi ew( Obj ect  cel l ,  Gr aphModel  model ,  

                   Cel l Mapper  cm)  {  super ( cel l ,  model ,  cm) ;  }  

  / /  Ret ur ns Per i met er  Poi nt  f or  El l i pses 

  publ i c  Poi nt  get Per i met er Poi nt ( Poi nt  sour ce,  Poi nt  p)  {  … }   

  / /  Ret ur ns t he Render er  f or  t hi s Vi ew 

  pr ot ect ed Cel l Vi ewRender er  get Render er ( )  {  

    r et ur n r ender er ;  

  }  



  / /  Def i ne t he Render er  f or  an El l i pseVi ew 

  st at i c  c l ass El l i pseRender er  ext ends Ver t exRender er  {  

    publ i c  voi d pai nt ( Gr aphi cs g)  {  … }  

  }  

}  

The reason for overriding get Render er  instead of get Render er Component  is that the 

Abst r act Cel l Vi ew class, from which we inherit, already provides a default implementation of 

this method that returns a configured Cel l Vi ewRender er , which in turn is retrieved through 

the method that was overridden. 

3.1.4.3. Adding Tooltips to a Graph 

Tooltips can be implemented by overriding JGraph’s get Tool Ti pText  method, which is 

inherited from the JComponent  class. The following displays the label of the cell under the 

mouse pointer as a tooltip. 

/ /  Ret ur n Cel l  Label  as a Tool t i p 

publ i c  St r i ng get Tool Ti pText ( MouseEvent  e)  {  

  i f ( e ! = nul l )  {  

    / /  Fet ch Cel l  under  Mousepoi nt er  

    Obj ect  c = get Fi r st Cel l For Locat i on( e. get X( ) ,  e. get Y( ) ) ;  

    i f  ( c  ! = nul l )  

      / /  Conver t  Cel l  t o St r i ng and Ret ur n 

      r et ur n conver t Val ueToSt r i ng( c) ;  

  }  

  r et ur n nul l ;  

}  

The graph must be registered with Swing’s TooltipManager to correctly display tooltips. This 

is done with the following code on startup: 

Tool Ti pManager . shar edI nst ance( ) . r egi st er Component ( gr aph)  

3.1.4.4. Customizing In-Place Editing 

In graphs that display complex structures, it is quite common to offer a property dialog instead 

of the simple in-place editing. To do this, the Basi cGr aphUI ’s st ar t Edi t i ng and 

compl et eEdi t i ng methods must be overridden. Then, in order to use this UI in a graph, the 

graph’s updat eUI  method must be overridden, too: 

/ /  Def i ne a Gr aph wi t h a Cust om UI  

publ i c  c l ass Di al ogGr aph ext ends JGr aph {  

  / /  Set s t he Cust om UI  f or  t hi s gr aph obj ect  

  publ i c  voi d updat eUI ( ) {  

    / /  I nst al l  a new UI  

    set UI ( new Di al ogUI ( ) ) ;  

    i nval i dat e( ) ;  



  }  

}  

The Di al ogUI  class takes the view’s editor, and puts it in a dialog, which blocks the frame 

until the dialog is closed.  

3.1.5 Dynamically changing a Graph 

In CSVT, either the model or the view is modified, or they are modified in parallel with a 

single transaction. When working on the model, objects that implement the Gr aphCel l  interface 

are used, whereas objects that implement the Cel l Vi ew interface are used in the context of a 

Gr aphVi ew. Gr aphVi ews  allow edit Cel l Vi ews , whereas Gr aphModel s  allow to insert, 

remove, and edit Gr aphCel l s . 

In this chapter, a Def aul t Gr aphModel  is used along with a graph that provides a view to 

the model. This way, we can clarify which methods belong to the model, and which belong to the 

view. 

Def aul t Gr aphModel  model  = new Def aul t Gr aphModel ( )  

JGr aph gr aph = new JGr aph( model ) ;  

3.1.5.1. Attributes 

CSVT separates the model and the view. The model is defined by the Gr aphModel  interface, 

and contains objects that implement the Gr aphCel l  interface, whereas the view is represented by 

the Gr aphVi ew class, and contains objects that implement the Cel l Vi ew interface. The 

mapping between cells and views is defined by the Cel l Mapper  interface: 

 

Fig. 4: Mapping between Gr aphCel l s  and Cel l Vi ews  

A model has zero or more views, and for each cell in the model, there exists exactly one 

Cel l Vi ew in each Gr aphVi ew. The state of these objects is repesented by a map of (key, value) 

pairs. Each Cel l Vi ew combines the attirbutes from the corresponding Gr aphCel l  with its own 

attributes. 

When combining the attributes from a Gr aphCel l  with the attributes from the Cel l Vi ew, 

the graph cell’s attributes have precedence over the view’s attributes. The special val ue attribute 

is in sync with the cell’s user object. 

3.1.5.2. Dynamically Changing Attributes 

The state of a cell, and likewise of a view is represented by its attributes. In either case, the 

Gr aphConst ant s  class is used to change the state in two steps: 



1. Construct the object that constitutes the change  

2. Execute the change on the model, or the graph view  

 

Fig. 5: Using maps to change the state 

To construct the object that constitutes the change, a new map is created using the 

cr eat eMap method of the Gr aphConst ant s  class. When a map is applied to a view’s or cell’s 

state, it does not replace the existing map. The entries of the new map are added or changed 

in-place. As a consequence, the Gr aphConst ant s  class offers the set RemoveAt t r i but es  

and set RemoveAl l  methods, which are used to remove individual or all keys from the existing 

state. (Note: The notion of states using maps closely resembles the structure of XML-documents.) 

3.1.5.3. Automatically Changing Attributes 

The updat e method of the Cel l Vi ew interface is used to message the Cel l Vi ew when 

one of its attributes was changed programmatically, or one of its neighbours has changed attributes. 

Thus, the updat e method is a good place to automatically set attributes, like for example the 

points of an edge. To reflect changes to the view’s corresponding cell, for example to point to the 

current source and target port, the r ef r esh method is used. 

3.2 Working with the GraphModel 

The model can be thought as an access point to two independent structures: the graph structure 

and the group structure. The graph structure is based on the mathematical definition of a graph, ie. 

vertices and edges. The group structure is used to enable composition of cells, ie. parents and 

childs. 

The graph structure is defined by the get Sour ce and get Tar get  methods, which return 

the source and target port of an object. The port in turn is a child of a vertex, which is used as an 

indirection to allow multiple connection points. 

The group structure is defined by the get Chi l d, get Chi l dCount , get I ndexOf Chi l d, 

and get Par ent  methods. The objects that have no parents are called roots, and may be retrieved 

using the get Root At  and get Root Count  methods. 



3.2.1  Inserting a Vertex into the Model 

Here is a method that creates a new Def aul t Gr aphCel l  and adds it to the model. The 

method adds two ports to the cell, and creates a map which maps the cells to their attributes. The 

attributes are in turn maps of (key, value) pairs, which may be accessed in a type-safe way by use of 

the Gr aphConst ant s  class: 

voi d i nser t Ver t ex( Obj ect  obj ,  Rect angl e bounds)  {  

  / /  Map t hat  Cont ai ns At t r i but e Maps 

  Map at t r i but eMap = new Hasht abl e( ) ;  

  / /  Cr eat e Ver t ex 

  Def aul t Gr aphCel l  cel l  = new Def aul t Gr aphCel l ( user Obj ect ) ;  

  / /  Cr eat e At t r i but e Map f or  Cel l  

  Map map = Gr aphConst ant s. cr eat eMap( ) ;  

  Gr aphConst ant s. set Bounds( map,  bounds) ;  

  / /  Associ at e At t r i but e Map wi t h Cel l  

  at t r i but eMap. put ( cel l ,  map) ;  

  / /  Cr eat e Def aul t  Fl oat i ng Por t  

  Def aul t Por t  por t  = new Def aul t Por t ( " Fl oat i ng" ) ;  

  cel l . add( por t ) ;  

  / /  Addi t i onal  Por t  Bot t om Ri ght  

  i nt  u = Gr aphConst ant s. PERCENT;  

  por t  = new Def aul t Por t ( " Bot t omr i ght " ) ;  

  / /  Cr eat e At t r i but e Map f or  Por t  

  map = Gr aphConst ant s. cr eat eMap( ) ;  

  Gr aphConst ant s. set Of f set ( map,  new Poi nt ( u,  u) ) ;  

  / /  Associ at e At t r i but e Map wi t h Por t  

  at t r i but eMap. put ( por t ,  map) ;  

  cel l . add( por t ) ;  

  / /  Add Cel l  ( and Chi l dr en)  t o t he Model  

  Obj ect [ ]  i nser t  = new Obj ect [ ] { cel l } ;  

  model . i nser t ( i nser t ,  nul l ,  nul l ,  at t r i but eMap) ;  

}  

The first argument to the i nser t Ver t ex  method is the user object – an object that contains 

or points to the data associated with the cell. The user object can be a string, or it can be a custom 

object. If you implement a custom object, you should implement its t oSt r i ng method, so that it 

returns the string to be displayed for that cell. The second argument represents the bounds of the 

vertex, which are stored as an attribute. 

Note: The vertex is passed to the i nser t  method without its children. The fact that 

parent-child relations are stored in the cells is used here to insert the children implicitly, without 

providing a Par ent Map.  

The at t r i but eMap argument is not used by the model. It is passed to the views to provide 

the attributes for the cell views to be created. The third parameter of the i nser t  call can be used 

to provide properties, that is, attributes that are stored in the model. 



3.2.2  Finding the Port of a Vertex 

Since ports are treated as normal children in the model (using the model’s group structure), the 

Gr aphModel  interface may be used to find the “default port”  of a vertex: 

Por t  get Def aul t Por t ( Obj ect  ver t ex,  Gr aphModel  model )  {  

  / /  I t er at e over  al l  Chi l dr en 

  f or  ( i nt  i  = 0;  i  < model . get Chi l dCount ( ver t ex) ;  i ++)  {  

    / /  Fet ch t he Chi l d of  Ver t ex at  I ndex i  

    Obj ect  chi l d = model . get Chi l d( ver t ex,  i ) ;  

    / /  Check i f  Chi l d i s  a Por t  

    i f  ( chi l d i nst anceof  Por t )  

      / /  Ret ur n t he Chi l d as a Por t  

      r et ur n ( Por t )  chi l d;  

  }  

  / /  No Por t s Found 

  r et ur n nul l ;  

}  

3.2.3  Inserting an Edge into the Model 

The following method creates a new Def aul t Edge, and adds it to the model, along with the 

connections to the specified source and target port. 

voi d i nser t Edge( Obj ect  obj ,  Por t  sour ce,  Por t  t ar get )  {  

  / /  Cr eat e Edge 

  Def aul t Edge edge = new Def aul t Edge( user Obj ect ) ;  

  / /  Cr eat e Connect i onSet  f or  I nser t i on 

  Connect i onSet  cs  = new Connect i onSet ( edge,  sour ce,  t ar get ) ;  

  / /  Add Edge and Connect i ons t o t he Model  

  Obj ect [ ]  i nser t  = new Obj ect [ ] { edge} ;  

  model . i nser t ( i nser t ,  cs,  nul l ,  nul l ) ;  

}  

The first argument represents the user object of the cell, and the second and third argument 

specify the source and target port of the new edge. To insert connections into a graph model, an 

instance of Connect i onSet  is required. The instance is used to collect the new ports and targets 

of edges, and execute the change as a single transaction. 

3.2.4  Changing the Model 

The Connect i onSet  and Par ent Map classes are used to change the model. The 

attributes may be changed using a map that contains cell, attributes pairs. The attributes are in turn 

represented by maps of key, value pairs, which may be accessed in a type-safe way by using the 

Gr aphConst ant s  class. 

Let edge, por t  and ver t ex  be instances of the Def aul t Edge, Def aul t Por t  and 

Def aul t Gr aphCel l  classes, respectively; all contained in the model. This code changes the 



source of edge to por t , the parent of por t  to ver t ex , and the user object of ver t ex  to the 

String Hello World. 

/ /  Cr eat e Connect i on Set  

Connect i onSet  connect i onSet  = new Connect i onSet ( ) ;  

connect i onSet . connect ( edge,  por t ,  t r ue) ;  

/ /  Cr eat e Par ent  Map   

Par ent Map par ent Map = new Par ent Map( ) ;  

par ent Map. addEnt r y( por t ,  ver t ex) ;  

/ /  Cr eat e Pr oper t i es f or  Ver t ex 

Map pr oper t i es = Gr aphConst ant s. cr eat eMap( ) ;  

Gr aphConst ant s. set Val ue( pr oper t i es,  " Hel l o Wor l d" ) ;   

/ /  Cr eat e Pr oper t y Map 

Map pr oper t yMap = new Hasht abl e( ) ;  

pr oper t yMap. put ( ver t ex,  pr oper t i es) ;  

/ /  Change t he Model  

model . edi t ( connect i onSet ,  pr oper t yMap,  par ent Map,  nul l ) ;  

The last argument of the edi t  call may be used to specify the initial edits that triggered the 

call. The edits specified are considered to be part of the transaction. (This is used to implement 

composite transactions, ie. transactions that change the model and the view in parallel.) 

3.2.5  Changing the View 

Each Gr aphCel l  has one or more associated Cel l Vi ews, which in turn contain the 

attributes. The attributes of a Cel l Vi ew may be changed using edi t Cel l s  on the parent 

Gr aphVi ew. In contrast to the pr oper t yMap argument used before, and the at t r i but eMap 

argument used to insert cells into the model, the at t r i but eMap argument used here contains 

instances of the Cel l Vi ew class as keys. The attributes, again, are maps of key, value pairs. 

The following changes the border color of ver t ex  to black: 

/ /  Wor k on t he Gr aph’ s Vi ew 

Gr aphVi ew v = gr aph. get Vi ew( ) ;  

/ /  Cr eat e At t r i but es f or  Ver t ex 

Map at t r i but es = Gr aphConst ant s. cr eat eMap( ) ;  

Gr aphConst ant s. set Bor der Col or ( at t r i but es,  Col or . bl ack) ;   

/ /  Get  t he Cel l Vi ew t o use as Key  

Cel l Vi ew cel l Vi ew = v. get Mappi ng( ver t ex,  f al se) ;  

/ /  Cr eat e At t r i but e Map 

Map at t r i but eMap = new Hasht abl e( ) ;  

at t r i but eMap. put ( cel l Vi ew,  pr oper t i es) ;  

/ /  Change t he Vi ew 

v. edi t Cel l s( at t r i but eMap) ;  
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